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ÖNSÖZ 

 

Günümüzde mobil teknolojinin yaygınlaşmasıyla pek çok elektronik ürünün müşteri 
konforunu sağlamayı amaçlayacak şekilde kullanımı ve kontrolü sağlanmaktadır. 
İklimlendirme alanında da bu alanda çalışmalar yapılmaya başlamıştır. Bu sayede yerli 
olarak üretilen iklimlendirme ürünlerinin mobil cihazlar üzerinden kontrolü ve 
izlenmesinin sağlanmasında bu tezin önemi ortaya çıkmaktadır. Bu tezin bir sonraki 
çalışmalara da yön göstermesi istenmiştir. 
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ÖZET  

 

EV TİPİ KLİMALARA KABLOSUZ AĞ ÜZERİNDEN UZAKTAN ERİŞİM VE 
KONTROL İLE AKILLI EV TEKNOLOJİLERİNİN GELİŞTİRİLMESİ 

 

Metin KARGACI 

 

Elektronik ve Haberleşme Mühendisliği Anabilim Dalı 

Yüksek Lisans Tezi 

 

Tez Danışmanı: Yrd. Doç. Dr. Nihan KAHRAMAN 

 

Bu tezde Arçelik-LG ev tipi inverter klima ürün gamından hedef seçilen ürünün uzaktan 
erişim ve kontrolü sağlanarak ithal ürünlere karşı yerli ürünlerde var olan dezavantajın 
azaltılması ya da tamamen sonlandırılması amacıyla yerli olarak geliştirilmesi, müşteri 
konforu ve enerji verimliliğinin artırılması hedeflenmiştir. Bu amaç kapsamında 
geliştirilen kontrol mekanizmasında kullanılan algoritmalar ve yenilikçi fikirler ön 
planda tutulmuştur.  

Tez kapsamında ilk önce literatür araştırması yapılmış ve yaygın olarak kullanılan 
uzaktan erişim ve kontrol yöntemleri incelenmiştir. Yöntem olarak kablosuz bağlantı 
alanı yani kablosuz ağ (wifi) teknolojisi seçilmiştir. Geliştirilen kablosuz erişim ve 
kontrol kartı prototipi ile inverter teknolojine sahip olan klima arasında seri 
haberleşme yöntemi kullanılmıştır. Prototip kart için yazılan yazılımım dili C 
programlama dilidir. Yazılım Energia geliştirme ortamının 0101E013 versiyonunda 
hazırlanmıştır. Tamamlanan bu yazılım Texas Instruments firmasının 16 bit işlemcisini 
barındıran MSP430F5529 geliştirme kartına yüklenmiştir. Uzaktan erişim ve kontrol 
uygulaması için bir Android tabanlı mobil bir arayüz ve bir web tabanlı PHP arayüz 
geliştirilmiştir. 

Bu tez çalışmasının sonucu olarak geliştirilen kablosuz haberleşme teknolojine sahip 
olan prototip ile inverter klimaya uzaktan erişim sağlanmış ve çeşitli klima kontrol 
fonksiyonları çalıştırılmıştır. Klimaya erişim ve kontrol için geliştirilen Android tabanlı 



xiii 

 

mobil uygulama ve PHP tabanlı web arayüz ile klima kontrolü sağlanmıştır. Bu 
uygulamalar sayesinde klimanın izlenmesi ve kontrolünün dışında klimadan kullanım 
istatistikleri ve kullanıcının kullanım alışkanlıklarının çıkarılabilmesine olanak verecek 
olan çeşitli bilgiler toplanmış, klimanın çalışma durumu, çalışma modu,  set edilen 
sıcaklık değeri, faz hızı gibi bazı bilgiler kullanıcının ihtiyacı düşünülerek erişimine 
açılmıştır. 

Anahtar Kelimeler: İnverter klima, seri haberleşme, elektronik kontrol sistemi, 
kablosuz haberleşme, wifi, android, php, web sunucu 
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ABSTRACT 

 

DEVOLOPING THE SMART HOME TECHNOLOGIES WITH HOME TYPE SPLIT 
AIR CONDITIONERS’S REMOTE ACCESS AND CONTROL VIA WIRELESS 

NETWORK  

Metin KARGACI 

 

Department of Electronics and Communications Engineering 

MSc. Thesis 

 

Adviser: Assist. Prof. Dr.Nihan KAHRAMAN 

 

This thesis describes development of remote access and remote control of home type 
inverter controlled air conditioners which are made in Turkey to reduce energy 
consumption and dependency of foreign countries and to increase user comfort. New 
designed methods and innovative ideas are important while developing the new 
control and access system structures. 

In this thesis firstly, literature survey is made and commonly used the remote access 
and control methods are examined. Wireless Fidelity method is determined. The 
remote access and remote control electronic card prototype is made. Developed 
prototype electronic card communicates with home type inverter air conditioner via 
UART – serial communication. Software is implemented using C programming language 
on MSP430F5529 development card which is supplied Texas Instruments 16-bit micro 
controller. Embebed software is developed with Energia IDE. Energia’s vesion is 
0101E013. An Android based mobile interface and web based PHP interface are 
developed for remote access and remote control of air conditioner. 

As a result of these studies, a prototype electronic card was designed and developed 
which is supplied by remote access and remote control features. Remote access and 
remote control of air conditioner is successfully achieved with using android based 
mobile application and web based PHP application. Commonly used air conditioner 
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functions are successfully executed. Various information of air conditioner’s using 
statics and user habits were collected. Users are allowed to access some information 
of their air conditioner. Such as working status, working mode, set temperature, fan 
speed etc. 

Keywords: Inverter Air conditioner, serial communication, electronic card system, 
wireless communication, Wi-Fi, android, PHP, web server  
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BÖLÜM 1 

GİRİŞ 

Bu tezde Arçelik-LG ev tipi inverter klima ürün gamından hedef seçilen ürünün uzaktan 

erişim ve kontrolü sağlanarak ithal ürünlere karşı yerli ürünlerde var olan dezavantajın 

azaltılması ya da tamamen sonlandırılması amacıyla yerli olarak geliştirilmesi, müşteri 

konforu ve enerji verimliliğinin artırılması hedeflenmiştir. Bu amaçla ilk önce literatür 

taraması yapılmıştır, daha sonra uygulama aşamasına geçilmiştir. Literatür 

araştırmasında uzaktan klima kontrolü ve erişim konusunda yayınlanan patentler ve 

makalelerle birlikte küresel bazda tasarım ve üretim yapan firmaların üretmiş olduğu 

ürünler incelenmiştir. Bölüm 1.1’ de bu bilgiler yer almaktadır. Bölüm 1.2’ de tezin 

yapılma amacı açıklanmıştır. Bu tezde hedef olarak seçilen ev tipi inverter klimaya 

uzaktan erişim ve kontrol uygulamaları gerçekleştirilmiştir. Bölüm 2’ de klima iç ünite 

kontrol sistemiyle haberleşebilen aynı zamanda klimaya kablosuz erişimi sağlayacak 

olan donanımı oluşturan elektronik kompanentler ile ilgili bilgiler verilmiştir. Bölüm 

3’de uzaktan erişim ve kontrol sistem mimarisi hakkında bilgiler verilmiştir. Aynı 

zamanda donanımsal altyapıyı çalıştıracak olan gömülü yazılım çalışmalarıyla birlikte 

mobil uygulama arayüzü ve web tabanlı arayüzün çalışma prensipleri hakkında bilgiler 

verilmiştir. 

1.1  Literatür Özeti 

Bilgi ve iletişim teknolojilerinin hızla gelişmesi ve özellikle Nesnelerin İnterneti’nin 

(Internet of Things) pek çok sektörü etkilediği gibi tüketici elektroniğiyle birlikte 

ısıtma/soğutma sektörünü de etkilemektedir. Ev tipi klimaların kullanımında kolaylık 
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sağlamak, enerji sarfiyatını azaltmak ve izlemek için klimalarında bu konsepte uygun 

olarak ek özelliklere sahip olması gerekmektedir.  

Küresel alanda bakıldığında tüm ısıtma/soğutma sistemlerinde uzaktan erişim, uzaktan 

kontrol ve uzaktan inceleme için teknolojinin bu yanının kullanılmaya başladığı 

görülmektedir. İncelenen patent ve makalelerde çeşitli uzaktan erişim ve kontrol 

yöntemlerinin kullanıldığı görülmektedir. Yerli üretim ürünlerde de bu teknolojik 

kontrol yönteminin kullanılmasına başlanmış ve ya ön çalışmaları yapılmaktadır.  

Yapılan literatür araştırmasında kablolu ve kablosuz yöntem olmak üzere iki farklı 

uzaktan erişim ve kontrol yöntemi görülmüştür. Bu yöntemlerde kendi içlerinde farklı 

teknolojilere sahiptir. 

Çizelge 1.1’de uzaktan erişim ve kontrol yöntemleri verilmiştir. Kablosuz yöntem olarak 

Zigbee, Bluetooth, Wi-Fi ve GSM teknolojisi dikkate alınmıştır. Bu 4 yöntem ayrıntılı 

olarak açıklanmıştır. Kablolu uzaktan erişim yöntemleri ise Ethernet ve PLC 

yöntemleridir. Ethernet yönteminde IP tabanlı sistem üzerinden her bir kontrol edilen 

ya da erişilen cihaza eşsiz bir kimlik numarası verilmektedir. Bu kimlik numaraları 

birbirinden farklı IP adresleridir. Kapalı sistemde yani internet üzerinden dış dünyaya 

erişimi olmayan sistemde ve açık olan yani internet ağı üzerinden dünyanın her 

yerinden sistemdeki bu cihazlara IP adresleri üzerinden erişim ve kontrol 

sağlanmaktadır. PLC yani Power Line Communication sisteminde elektrik şebeke 

hattının kullanılarak veri haberleşmesi sağlanmaktadır. Yüksek frekanslı kare dalgalar 

gönderilerek karşı taraftaki cihazların gelen işareti alması sağlanmaktadır. Yüksek 

frekanslı bu işaretler başlangıç biti, sorgu, istek ya da genel fonksiyon bitleri ile en 

sonunda sonlandırma biti olan bir paket yapısından oluşmaktadır. 

Çizelge 1.1 Uzaktan erişim ve kontrol yöntemleri 

Kablosuz Yöntemler Kablolu Yöntemler 

Zigbee  
Ethernet 

Bluetooth 

Wi-Fi PLC – Power Line 
Communication 
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1.1.1 Zigbee 

ZigBee, 2007 yılında ZigBee Alliance tarafından geliştirilen endüstriyel otomasyon 

amaçlı, düşük maliyetli ve düşük güç tüketimine sahip 802.15.4 tabanlı bir kablosuz 

sensör ağı teknolojisidir.  

Başlıca özellikleri aşağıdaki gibidir: 

 2,4 GHz çalışma frekansı 

 250 Kbps veri iletim hızı 

 Toplam 65536 ağ düğümünü adresleyebilir. 

 Her ağ düğümü 240 sensör içerebilir.  

 Lisanslı kullanıcı olmak ve geliştirme çalışmalarında etkin görev alınabilen bir 

organizasyona sahiptir [1].   

 

Şekil 1.1 Zigbee erişim seçenekleri [2] 

1.1.2 Bluetooth 

Bluetooth cihazları 2,4GHz ISM (Industrial Scientific Medical Band) bandında 

çalışmaktadır.  
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Bu frekans kanalı, Fransa hariç, tüm dünyada herkes tarafından lisanssız 

kullanılabilmektedir.  

Bluetooth ile hem noktadan noktaya (point – to – point) hem de noktadan çok noktaya 

(point – to – multipoint) bağlantıları kurmak mümkündür [3].  

 

Şekil 1.2 Bluetooth star topoloji [4] 

1.1.3 WI-FI (WIRELESS FIDELITY) 

IEEE 802.11a, IEEE 802.11b, IEEE 802.11g ve IEEE 802.11n standartlarını kullanan 

kablosuz olarak internete bağlanmasını sağlayan teknolojidir. Wi-Fi teknolojisiyle 

dizüstü bilgisayarlar, PDA’lar, cep telefonları ve diğer mobil cihazlar yakınlarındaki 

kablosuz erişim noktaları aracılığıyla yerel ağlarla olan bağlantıları sağlanmaktadır. 

Bağlantı frekansı IEEE 802.11 protokolüne bağlı olarak 2,4 GHz ya da 5 GHz 

aralığındadır. Gönderilen veri, ilgili protokole uygun bir şekilde gönderilir ve bu sayede 

veri paketlerinin iletimi sırasında hata oluşma olasılığı ortadan kaldırılır. 

Lisans gerektirmeyen frekanslarda çalışır 

 Ağ için kablolama gereksinimi yoktur, böylece kablo çekilemeyecek binalarda 

veya binalar arası bağlantılarda kolaylık sağlar. 
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 Diğer kablosuz çözümlere göre çok daha ucuz ve kolay alınıp kurulabilir. 

 WEP, WPA ve benzeri kablosuz şifreleme yöntemleri veya IEEE 802.1x gibi 

yetkilendirme yöntemleriyle çeşitli güvenlik seçenekleri sunar [5]. 

Çizelge 1.2’de ilgili kablosuz ağ yayın standardının kıtalara, ülkelere veya bölgelere göre 

kullanılan kanal sayısı ve frekans aralıkları verilmiştir. 

Çizelge 1.1 Frekanslar [5] 

Standart Frekanslar Kanal Sayısı 

IEEE 802.11a 5,15 GHz ­ 5,725 GHz 19, Avrupa'da TPC ve DFS 802.11h 

IEEE 802.11b 2,4 GHz ­ 2,4835 GHz 
11 Adet ABD, 13 Adet Avrupa,14 Adet 
Japonya 

IEEE 802.11g 2,4 GHz ­ 2,4835 GHz 11 Adet ABD, 13 Adet Avrupa,14 Japonya 

 

Kanal genişliği tüm standartlarda 10 ile 30 MHz arasındadır. Çizelge1.3’de her bir 

kablosuz ağ alanın standardının verebildiği maksimum veri hızları verilmiştir. 

Çizelge 1.2 Veri hızı [5] 

IEEE 802.11 2 Mbps max. 

IEEE 802.11a 54 Mbps max. (40 MHz'ta 108 Mbps) 

IEEE 802.11b 11 Mbps max. (40 MHz'ta 22 Mbps, 60 MHz'ta 44 Mbps) 

IEEE 802.11g 
54 Mbps max. (g+ =108 Mbps, 125 Mbps'a kadar mümkün; 2 
Mbps Karma (g+b) IEEE 802.11b) 

IEEE 802.11h 54 Mbps max. (40 MHz'ta 108 Mbps) 
 

IEEE 802.11n 
300 Mbps max. (kullanılan Teknik MIMO; 20. Ocak 2006'da 
tasarlandı; Versiyon 2.0 19. Mart 2007'de geliştirildi) 

 

Veri hızında dikkat edilecek unsur, “yükleme” ve  “indirme” için paylaştırılıyor. Sadece 

indirme için bu max. hızı beklememek gerekir. Ayrıca alıcı ile verici cihaz arasındaki 

mesafe ve cihazların arasında bir engel olup olmaması, hızı o oranda olumsuz yönde 

etkiliyor.  

Kablosuz iletişimde radyo sinyalleri kullanıldığı için, kullanıcı ile kablosuz erişim noktası 

arasındaki iletişim dinlenebilmektedir. Bunu engellemek için WEP, WPA ve WPA2 gibi 

şifreleme yöntemlerinin kullanılmasına rağmen yine de bu şifreleme yöntemleri 

yeterince güveli olmayabilmektedir. Eğer yeterli miktarda şifreli paket toplanırsa birçok 
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şifreli kablosuz iletişim çözülebilir. Bu nedenle kurumsal firmalar VPN ve benzeri üst 

katmanlarda çalışan şifreleme yöntemleri kullanmaktadırlar. Bu yöntem için kullanılan 

protokol 802.1x’dir [5].  

1.1.4 GSM 

Global System for Mobile Communications veya kısaca GSM (Mobil İletişim İçin Küresel 

Sistem), bir cep telefonu iletişim protokolüdür. Önceleri Avrupa Telekomünikasyon 

Standartlar Komitesi'nin Groupe Spéciale Mobile (Mobil İletişim Özel Grubu) isimli alt 

kuruluşunun ismini taşıyan GSM, daha sonraları sistemin küresel bir çapa ulaşmasıyla 

yeni adıyla anılmaya başlanmıştır. En yaygın olan cep telefonu standardı olarak 212 

ülkede iki milyardan fazla insan tarafından kullanılmaktadır. En kullanışlı özelliklerinden 

birisi kullanıcıların aynı hat ile değişik ülkelerden görüşme (roaming) yapabilmeleridir. 

Tüm GSM standartları, hücresel ağ kullanır ve dolaşım sırasında bile hücreler arası geçiş 

yapma kabiliyetine sahiptir. Dolayısıyla teoride, eğer kapsama alanından çıkılmazsa, 

cep telefonu ile tüm dünyayı telefon konuşmasını kesmeden dolaşmak mümkündür [6].  

Çizelge 1.3 GSM nesil ve çeşitleri [6] 

GSM Nesilleri GSM Çeşitleri 

0G GSM2100 

1G GSM1900 

2G GSM1800 

2.5G GSM900 

3G GSM850 

4G  

1.1.5 Kablosuz Haberleşme Yöntemlerinin Karşılaştırılması 

Karşılaştırılma yapılırken teknolojinin mevcut durumda kullanım yaygınlığı, sistem 

maliyeti, kurulum kolaylığı, bağlanabilir cihaz sayısı, enerji sarfiyatı, haberleşme hızı gibi 

kriterler hep birlikte göz önüne alınmıştır. Bu kriterler çerçevesinde bu tez çalışmasında 

kablosuz erişim ve kontrol yöntemi olarak Wireless Fidelty yani Wi-Fi teknolojisi en 

https://tr.wikipedia.org/wiki/Cep_telefonu
https://tr.wikipedia.org/wiki/Cep_telefonu
https://tr.wikipedia.org/wiki/Roaming
https://tr.wikipedia.org/wiki/Roaming
https://tr.wikipedia.org/wiki/H%C3%BCcresel_a%C4%9F
https://tr.wikipedia.org/wiki/H%C3%BCcresel_a%C4%9F
https://tr.wikipedia.org/wiki/H%C3%BCcreler_aras%C4%B1_ge%C3%A7i%C5%9F
https://tr.wikipedia.org/wiki/H%C3%BCcreler_aras%C4%B1_ge%C3%A7i%C5%9F
https://tr.wikipedia.org/wiki/Cep_telefonu
https://tr.wikipedia.org/wiki/Cep_telefonu
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uygunu olduğu görüldü. Çizelge 1.5’de yukarıda açıklanan yöntemlerin yöntemin genel 

bir karşılaştırılması gösterilmiştir. 

Çizelge 1.4 Kablosuz haberleşme yöntemlerinin karşılaştırılması [7] 

 Zigbee GPRS/GSM Wi-fi Bluetooth 

 

Odaklanma Alanı 

 
İzleme ve 
Kontrol 

Geniş Alan 

Ses ve Veri 
iletimi 

Web, posta, 
izleme, 
kontrol 

Kablo 
yerine 

Sistem Kaynağı 4 - 32Kb 16 Mb+ 1 Mb+ 250 Kb+ 

Ağ Veri Genişliği 

(kb/s) 

20-250 64 -128+ 11000+ 720 

Kapsama(metre) 1-100 1000+ 1-100 1-10+ 

1.1.6 Patent Özetleri 

Air conditioner control system using public switched telephone network and method 

for operating the same - EP1408289-A2 [8] 

Yoon Sang CHUL ve arkadaşlarının LG Electronics adına 2004 yılında aldıkları klimalara 

uzaktan erişim patentinin uygulamasında geleneksel halka açık telefon şebekesini 

kullanarak bir ve/veya birden fazla klimanın kontrolü sağlanmıştır. Yapılan bu patent 

çalışmasında oluşturulmak istenen sistem yapısı Şekil 1.3’de gösterilmiştir. 



 

8 

 

 

Şekil 1.3 Telefon hattı kullanılarak oluşturulan klima kontrol ve erişim sistem yapısı [8] 

Çoklu klima sistemlerinde her bir klimaya özel kimlik numarası “ID” verilerek kontrol 

sağlanmıştır. Sistemde verici modül seri dönüştürücü ile elektronik cihaza bağlanır ve 

sinyal kodlayıcı ile veri kodlanıp DTMF sinyali ile gönderilmektedir. DTMF sinyali telefon 

hattı üzerinden alıcı modül üzerinden sinyal çözücüden geçerek klimaya iletilir ve bu 

sayede klima kontrol edilebilmektedir [8]. 

Apparatus for monitoring air conditioner - EP1662210A1 

Chung Baik Young ve arkadaşlarının 2006 yılında aldıkları patentte klimanın izlenmesi 

için gerekli bir cihaz tarif edilmektedir. Bu cihaz klimaya bağlı kablosuz modül ve izleme 

ekranın bağlı ikinci bir kablosuz cihazdan oluşmaktadır. Mevcut sistemde klimada 

herhangi bir sorun olduğunda izlemek için klima ile monitör arasında bir kablolu cihaz 

kullanılmaktaydı [9]. Bu yapı Şekil 1.4’de gösterilmektedir. 



 

9 

 

 

Şekil 1.4 Geleneksel kablolu klima izleme sistem yapısı [9] 

 Young ve arkadaşları Şekil 1.5’de gösterilen önerdikleri bu sistemde klimayı izlemek 

için kablolu cihazlar yerine kablosuz modüller kullanmaktadırlar. Bu sayede hem insan 

gücünden hem de maliyetten tasarruf sağlanmaktadır [9].  

 

Şekil 1.5 Kablosuz klima izleme sistem yapısı [9] 

Method of controlling a network apparatus - EP2477378A1 [10]  

Eun YOUSOOK ve arkadaşlarının 2012 yılında aldıkları patentte taşınabilir bir cihaz ile 

(cep telefonu, tablet bilgisayar, dizüstü bilgisayar vs.) ortam bilgisi alınarak klimanın bu 

bilgiler çerçevesinde çalışması sağlanmaktadır [10]. Şekil 1.6’da klimaya uzaktan erişim 

ve kontrol için kullanılan mobil cihaz sistemi gösterilmiştir. 
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Şekil 1.6 Klimaya uzaktan erişim kontrol için mobil cihaz kullanımı [10] 

Bu sistemde GPS ile yer bilgisi alınıp kontrol edilerek web sunucudan çevresel hava 

durumu bilgileri alınarak bu bilginin klimaya gönderilerek klimanın en verimli şekilde 

çalıştırılması başarılmıştır [10]. Şekil 1.7’de mobil cihazın klima kontrolünde kullanılan 

yazılım akış şeması verilmiştir. Şemaya göre mobil cihaz dış ortam bilgisi alınması 

gerektiğinde sensörlerden gelen bilgileri kaydetmeye hazırlanmaktadır. Diğer yandan 

ise GPS ise klimanın kurulu olduğu konumun coğrafi bilgilerini almak için GPS 

modülünü çalıştırmaktadır. GPS modül çalıştığında coğrafi konuma bağlı olarak sıcaklık 

ve nem bilgileri mobil uygulama üzerinden klimaya gönderilmektedir. Gelen bilgi klima 

tarafından yorumlandıktan sonra klima analiz ettiği veriye göre çalışmasına karar 

vermektedir. 
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Şekil 1.7 Mobil cihazla klima kontrol sistemi akış şeması [10] 
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1.1.7 Yayın Özetleri 

Research on the Low-Power of Air-Conditioner Remote Control System Terminal 

Device Based on Zigbee Technology - 3rd International Conference on System 

Science, Engineering Design and Manufacturing Informatization, 2012 [11] 

Yang ve arkadaşlarının 2012 yılında yayınladıkları bildiride, akıllı ev uygulamalarında, 

klima kontrol cihazı yönetim şebekesinde Zigbee teknolojisi kullanıldığında, bu 

şebekedeki pille beslenen ürünlerin güç tüketimlerinin azaltıldığı önerilmiştir. Bu 

kapsamda CC2530 ve MSP430 ile pille beslenen donanımlar için bir araştırma 

yapılmıştır. Araştırmayı yapanlar yazılım ve donanım cihazlarının optimizasyonu 

üzerinden kullanılan cihazların çalışma ömrünü uzatan, güç tüketimini azaltan ve 

sistem maliyetlerin azaltan bir yapı sunmaktadırlar. Test sonuçlarına göre yapılan bu 

çalışma sayesinde “düşük güçlü işlem terminal donanımından sonra “ 800mAh 1.5V luk 

iki adet bataryanın çalışma ömür 11 günden 280 güne çıkarılmıştır [11]. 

Yang’ın oluşturduğu sistem tasarımı Şekil 1.8’de gösterilmiştir. 

 

Şekil 1.8 Klima kontrol sistemi [11] 

Düşük güçlü klima kontrol sisteminin yazılım akış şeması Şekil 1.9’da, CC2530 düşük 

güçlü Zigbee modülün yazılım akış şeması ise Şekil 1.10’da gösterilmiştir. 
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Şekil 1.9  Klima Uzaktan Kontrol Sistemi Terminal Donanımı Düşük Güçlü Çalışma 
Yazılımı Akış Şeması [11] 
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Şekil 1.10  CC2530 yazılım akış şeması [11] 

Xiaoling YANG’ın yapmış olduğu bu çalışmada sonuç olarak, düşük güç tüketimli klima 

uzaktan kontrol sistem terminal cihazı Zigbee teknolojisinin hem donanımına hem de 

yazılımına dayalıdır. Bu araştırma öncesindeki denemelerde klimaya günlük olarak 25 

adet komut gönderildiğinde ortalama olarak 2,7mA akım çektiği belirlenmiştir. 

Araştırma sisteminin kullanılması durumunda bu değer 100uA değerine kadar 

düşmektedir. Bu sayede iki adet 800mAh lik pil ile 11 gün olan çalışma ömrünü 280 

güne çıkartılabilmiştir. Zigbee teknolojisi sayesinde bu tip sistemlerde büyük oranda 

enerji tasarrufu sağlandığı görülmüştür [11]. 
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Non-invasive Zigbee wireless controller for airconditioner energy saving - Wireless 

Communications, Networking and Mobile Computing (WiCOM), 2011 7th 

International Conference on [12] 

Chuah ve arkadaşlarının 2011 yılında yayınlanan bildiride split klima ünitelerinin 

kontrolüyle enerji tasarrufu sağlayan yenilikçi Müdahalesiz (Non-invasive) Zigbee 

tabanlı kablosuz kontrolör anlatılmaktadır. Kontrolör klimanın sıcaklık sensörüne bağlı 

olmalıdır. Kontrolörün birincil fonksiyonu klima ünitesinin on/off fonksiyonlarını Zigbee 

tabanlı kablosuz sensörden okuduğu bilgiye göre etkilemektir. Enerji tasarrufu 

kullanılan alan koşullarındaki konforun kontrolü sayesinde ve merkezi uzaktan kontrol 

sistemine bağlandığında uygun zamanlamayla yapılmaktadır. Bu çalışma üzerindeki 

deneyimler bu kontrol yöntemini kablosuz sensör ağının bir parçası olmasıyla maliyeti 

çok düşük seviyelere yaydığı görülmektedir. Bu uygulama klimanın iç kılıfında ya da 

split ünitelerinde kullanılabilir. Ölçülen enerji tasarrufu seviyesi bir split klima için bu 

kontrol yöntemiyle %50’yi aşan bir değere ulaşmaktadır. Bu nedenle bu yöntem 

klimada enerji tasarrufu sağlamada önemli bir potansiyele sahiptir [12]. 

Genel sistem yapısı Şekil 1.11’de gösterilmiştir. 

 

Şekil 1.11 Kablosuz sensör ağı sistemi [12] 
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Şekil 1.11’de görülen sistemde soğutulması öncelikli alanlara kablosuz sensörler ve 

termal çiftler yerleştirilmiştir. Bu yerleşim Şekil 12’de gösterilmiştir. Yapılan bu 

yerleşimde sensörlerden gelen bilgiye göre klimanın çalışma modu ve gerekli 

performans şartları belirlenmekte ve klima bu şartlara göre çalışmasını sürdürmektedir. 

 

 

Şekil 1.12 Termal çiftlerin ve kablosuz sensörlerin yerleşim konum planı [12] 

Chuah ve arkadaşlarının yayınlamış olduğu bu bildirinin sonuçları arasında klima 

üniteleri için bir yenilikçi kablosuz kontrol yönteminin başarıyla gerçekleştirildiği 

belirtilmiştir. Zigbee tabanlı kablosuz kontrol yöntemi kullanılmış ve bir kontrolör ile 

enerji tasarrufu verimliliği test edilmiştir. Sistemde kablosuz sensörler birinci soğutma 

talebi olan alanlara yerleştirilmiş ve bu sayede gerekli miktarda soğutma yapılarak aşırı 

soğumanın önüne geçildiği gözlemlenmiştir. Bu çalışmanın sonucunda oluşturulan 

sistem sayesinde %50 oranında bir enerji tasarrufu başarıyla elde edildiği görülmüştür 

[12].  

1.1.8 Kablosuz Erişim ve Kontrollü Klimalar 

1.1.8.1 Samsung Akıllı Seri 

Samsung firmasının split tipi klimalarının “Akıllı” serisi ürünlerinde kablosuz ağ (Wifi) 

erişimi entegre edilmiştir. Bu özellik için ayrı bir modül tasarlanıp üretilmiştir. Modül 

USB kablo ile iç üniteye monte edilmektedir. Uzaktan erişim arayüzü olarak SmartAir 

Conditioner isimli hem Android [13] hem de IOS [14] işletim sistemlerinde iki uygulama 
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yapılmıştır. Bu uygulamalar sayesinde kullanıcı klimasını geleneksel kumandasından 

nasıl kontrol edebiliyorsa aynı şekilde kontrolünü sağlamaktadır. Geleneksel 

kumandaya ek olarak klimanın çalışma durumunu, güç tüketimini, kullanım kılavuzuna 

da bu mobil uygulamalar sayesinde bulunduğu her yerden erişebilmektedir [15]. Şekil 

1.14’de Samsung akıllı seri klimalarda kullanılan kablosuz ağ erişim modülünün klima iç 

ünitesindeki yerleşimi gösterilmiştir. 

 

Şekil 1.13 Samsung akıllı iklimlendirme serisi [15] 

 

Şekil 1.14 Kablosuz ağ modülünün iç ünitede yerleşim şekli [15] 

Şekil 1.15’te Samsung akıllı seri klimalara uzaktan erişim ve kontrol için kullanılan 

SmartAirConditioner mobil uygulamasının Android ve IOS tabanlı arayüzleri verilmiştir. 
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Şekil 1.15 Samsung akıllı iklimlendirme Android *13+ ve IOS *14+ tabanlı mobil uygulama 
arayüzleri 

1.1.8.2 DAIKIN SKYFI 

Daikin firmasının SKYFI isimli kablosuz ağ (wifi) modülü ile split klimalara erişim 

sağlanmaktadır. SKYFI modülü tıpkı Samsung firmasının ürünü gibi ayrı bir modül olarak 

tasarlanmıştır. Kullanıcı isteğine bağlı olarak satılmaktadır. Bir veri ve güç kablosu 

kullanılarak iç üniteye bağlanmaktadır. Cihaz enerjisi aldıktan sonra erişim ve kontrole 

hazır hale gelmektedir. Kullanıcılar uzaktan erişim ve kontrol için SKYFI isimli hem 

Android [16] hem de IOS [17] tabanlı kullanıcı arayüzleri geliştirilmiştir. Bu arayüzler 

sayesinde klimaya klimanın bulunduğu mekan içinden ya da dışından erişim 

sağlanmıştır [18]. Şekil 1.16’da Daikin SKYFi sisteminin Android ve IOS tabanlı mobil 

uygulama arayüzleri gösterilmiştir. 
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Şekil 1.16 SKYFI Android *16+ ve IOS *17+ tabanlı mobil uygulama arayüzleri 

1.1.8.3 MITSUBISHI MELCloud 

Mitsubishi firmasının MELCloud adlı uzaktan erişim ve kontrol paketi bulunmaktadır. 

Diğer firmalarda olduğu gibi kablosuz ağ (wifi) uzaktan erişim ve kontrol modülü harici 

olarak satılmaktadır. Bağlantısı veri ve güç kablosu üzerinden yapılmaktadır. Modül 

çalıştırıldığında akıllı telefon ya da dizüstü bilgisayar ile direk olarak yapılmaktadır. 

Dışarıdan bağlantı için ise kablosuz internet ağına bağlı olan modüle internet ağından 

erişilmektedir [19]. Şekil 1.17’de MELCloud sisteminde klimalara uzaktan erişim ve 

kontrol için kullanılan kablosuz yerel alan ağı kablosuz ağ erişim modülü gösterilmiştir. 

 

Şekil 1.17 MELCloud kablosuz yerel alan ağı kablosuz ağ (wifi) modülü [19] 
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Şekil 1.18’de MELCloud sisteminin genel bağlantı diyagramı 

verilmiştir.

 

Şekil 1.18 MELCloud kablosuz yerel alan ağı kablosuz ağ modülü bağlantı şekli [19] 

Erişim için hem Android [20] hem de IOS [21] tabanlı MELCloud uygulaması mevcuttur. 

Şekil 1.19’daMELCloud sisteminin Android ve IOS tabanlı arayüzleri gösterilmiştir.  

 

Şekil 1.19 MELCloud Android *20+ ve IOS *21+ tabanlı mobil uygulama arayüzleri 

1.1.8.4  LG SMART AC 

LG firmasının inverter artcool stylish modelinde kablosuz ağ (wifi) ile uzaktan erişim 

özelliği bulunmaktadır. Klima pazarındaki rakipleri gibi LG firması da kablosuz ağ 

modülünü harici olarak tasarlamıştır [22]. 
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Şekil 1.20 LG akıllı iklimlendirme kablosuz yerel alan ağı kablosuz ağ modülü [22] 

Kablosuz ağ modül USB kablo aracılığıyla iç üniteye bağlanmaktadır.  SMART AC 

kablosuz yerel alan ağı kablosuz ağ  modülüne bağlantı Android [23] ve IOS [24] tabanlı 

arayüzler üzerinden gerçekleştirilmektedir. Şekil 1.21’de LG Smart AC Android tabanlı 

mobil uygulama arayüzü, Şekil 1.22’de ise IOS tabanlı mobil uygulama arayüzü 

gösterilmiştir. 

 

 

Şekil 1.21 LG akıllı iklimlendirme Android *23+ tabanlı mobil uygulama arayüzü 
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Şekil 1.22 LG akıllı iklimlendirme IOS*24+ tabanlı mobil uygulama arayüzü 

1.1.8.5 INTESIS HOME 

Inteis Home adlı oluşumun uzaktan erişim modülü ile oluşuma dahil olan firmaların 

klimalarına uzaktan erişim ve kontrol sağlanmaktadır. Klimalara erişim mobil uygulama 

üzerinden ya da internet tarayıcısı kullanılarak yapılmaktadır. Geliştirilen Android [25] 

ve IOS [26] tabanlı mobil uygulamalar sayesinde klimalar hakkında çeşitli bilgilere 

ulaşılabilmektedir. 

 

Şekil 1.23 IntesisHome oluşumunu destekleyen firmalar [27] 

 

Şekil 1.24 IntesisHome kablosuz yerel alan ağı kablosuz ağ modülü [27] 
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Geliştirilen mobil uygulamalar sayesinde klimanın enerji tüketimi izlenebilmektedir. 

Ayrıca klimanın bakım zamanı geldiğinde ya da filtre değişimi gerektiğinde bu mobil 

uygulamalar üzerinden kullanıcı bilgilendirilmektedir [27]. 

 

Şekil 1.25 IntesisHome akıllı iklimlendirme Android*25+ tabanlı mobil uygulama arayüzü 

 

 

Şekil 1.26 IntesisHome akıllı iklimlendirme IOS*26+ tabanlı mobil uygulama arayüzü 
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1.2 Tezin Amacı 

Küresel çapta yaygınlaşan fakat yerli üretim Arçelik ev tipi inverter klima ürünlerinde 

olmayan uzaktan erişim ve kontrol teknolojisi kullanılarak bu alandaki eksikliği 

kapatacak yenilikçi uzaktan erişim ve kontrol biriminin tasarımı bu yüksek lisans tezinin 

amacı olarak belirlenmiştir.  

1.3 Hipotez 

Arçelik-LG Klima Sanayi A.Ş. ile üniversite-sanayi iş birliği kapsamında ev tipi klimalarda 

kullanılmak üzere bir akıllı kontrol ve erişim sisteminin tasarlanması, uzaktan erişim ve 

kontrol testlerinden ve güvenlik testlerinden başarıyla geçerek akıllı ev teknolojilerine 

faydalı bir çıktı olması hedeflenmektedir. 
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BÖLÜM 2 

KLİMA UZAKTAN ERİŞİM  ve KONTROL DONANIMI 

Bu tez çalışmasında uzaktan erişim ve kontrolü sağlamak amacıyla iki geliştirme kartı 

kullanılmıştır. Geliştirme kartının seçiminde farklı üreticilerin ürünleri incelenmiştir. 

Bunlar arasında Microchip firmasının RN-171-EK [28] EK Texas Instruments’ın 

CC1200DK [29], CC2538DK [30], MSP430F5529 LAUNCHPAD [31], CC3000 

BOOSTERPACK [32], Telit’in EVK2 [33], Broadcom firmasının ise WICED Wi-Fi [34]  

ürünleri araştırılmıştır. Microchip, Texas Instruments, Telit ve Broadcom gibi firmaların 

kablosuz haberleşme sağlayan ürünlerinin arasından yapılan seçim sonrasında Texas 

Instruments firmasının geliştirme kartlarına karar kılındı. Bunun nedenleri arasında 

donanım temini, dokümantasyon erişimi, yazılım geliştirme ortamı seçenekleri gibi 

kriterler göz önüne alınmıştır. Geliştirilen kablosuz uzaktan erişim ve kontrol donanım 

prototipinde mikro işlemci olarak MSP430 serisi işlemciye sahip olan MSP430F5529 

geliştirme kartı ile kablosuz haberleşmeyi sağlayacak olan CC3000 Kablosuz ağ 

geliştirme kartı kullanılmıştır.   
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2.1 MSP430F5529 GELİŞTİRME KARTI 

 

Şekil 2.1 MSP430F5529 geliştirme kartı [35] 

Texas Instruments firmasının ürünü olan MSP430F5529 LP donanımsal özellikleriyle bu 

projemiz için yeterli olmaktadır. Donanımsal ve yazılımsal özellikleri aşağıdaki gibidir. 

USB özellikli MSP430F5529 16 bit mikro denetleyici 

25 Mhz hızına kadar Sistem Clock’u 

Çalışma voltajı: 1.8-V – 3.6-V 

128 KB flaş bellek, 8 KB RAM (2 KB USB modülü kullanır) 

5 Zamanlayıcı(TIMER) 

4 seri haberleşme desteği (SPI, UART, I²C) 

12 bit A/D dönüştürücü 

Analog komparatör 

Tüm araçları, kütüphaneleri, örnekleri ve referans kılavuzlarıyla bütünleşmiş USB 

eZ-FET emülatör 

USB üzerinden güç beslemesi 

5V – 3,3 V DC-DC dönüştürücü 

40-pin erkek dişi ek paket yuvaları [35] 

Şekil 2.2’de MSP430F5529 geliştirme kartının blok diyagramı verilmiştir. 
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Şekil 2.2 MSP430F5529 geliştirme kartı blok diyagramı [35] 

Şekil 2.3’te MSP430F5529 geliştirme kartının önemli özellikleri ve yapılandırma 

kontrolörleri  gösterilmiştir. 
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Şekil 2.3 MSP430F5529’un önemli özellikleri ve yapılandırma kontrolörleri [35] 

Şekil 2.4 ve Şekil 2.5’te MSP430F5529 geliştirme kartının pin yapısı ayrıntılı olarak 

gösterilmiştir. 

 

Şekil 2.4 MSP430F5529 LP pin şematiği 1 [35] 
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Şekil 2.5 MSP430F5529 LP pin şematiği 2 [35]  

2.2 CC3000 WI-FI KABLOSUZ HABERLEŞME GELİŞTİRME KARTI 

 

Şekil 2.6 CC3000 BoosterPack kablosuz haberleşme geliştirme kartı [36] 

Bu tez kapsamında mikro işlemci olarak MSP430F5529 geliştirme kiti ile birlikte 

uzaktan erişim ve kontrolü sağlayacak olan Texas Instruments firmasının Wi-Fi 

teknolojini destekleyen CC3000 kablosuz haberleşme geliştirme modülü kullanılmıştır. 

CC3000 kablosuz haberleşme geliştirme modülünün teknik özellikleri Çizelge 2,1’de 

verilmiştir. Çizelge 2.1’de CC3000’de kullanılan haberleşme standardının IEEE 802.11 

b/g olduğu, veri alma ve veri gönderme güçlerinin teknik değerleri, enerji sınıfı, çalışma 

koşulları ve sahip olduğu sertifika ile anten yapısından bahsedilmektedir [36].  
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Çizelge 2.1 CC3000 Teknik Özellikleri [36] 

Kablosuz ağ işlemcisi 

IEEE 802.11 b/g 

Gömülü IPv4 TCP/ IP 

En iyi radyo frekans sınıfı 

Tx gücü: +18.0 dBm, 11 Mbps, CCK 

Rx hassasiyeti: -88 dBm, 8% PER, 11 Mbps 

Low MIPS ve Low-cost MCU ile çalışma 

FCC, IC ve CE sertifikalı çip anten 

Entegre kristal ve güç yönetimi 

- 20°C to 70°C aralığında çalışma 

 

CC3000 kablosuz haberleşme geliştirme modülü; 

Ev otomasyonu 

Ev güvenliği 

Akıllı Enerji 

M2M haberleşme 

gibi uygulamalarda kullanılmaktadır. 

Şekil 2.7’de CC3000 kablosuz haberleşme geliştirme kartının üst yüzey görünüşü yer 

almaktadır. Kablosuz ağ işlemcisi, anten, harici güç girişi, çalışma modu seçici pin 

başlıkları CC3000 kablosuz haberleşme geliştirme kartının üst yüzeyinde bulunmaktadır 

[36]. 
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Şekil 2.7 CC3000 BoosterPack geliştirme kartı üst yüzey görünüş [36] 

Şekil 2.8’de CC3000 kablosuz haberleşme geliştirme kartının alt yüzey görünüşü yer 

almaktadır. Alt yüzeydi J9 ve J10 dişi pin grupları bulunmaktadır. Bu pin grupları 

sayesinde CC3000 kablosuz haberleşme modülü harici mikro kontrolör geliştirme 

kartlarıyla bütünleştirilebilir, enerjisini harici kartlar üzerinden alabilir ve SPI 

haberleşmesini de yine bu pin gruplar üzerinden yapmaktadır. 

 

Şekil 2.8 CC3000 BoosterPack geliştirme kartı alt yüzey görünüş [36] 
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J9 pin bloğunun ayrıntılı açıklaması Çizelge 2.2’de gösterilmiştir. Çizelgede güç girişi, 

sinyal girişi, SPI haberleşme Clock girişi ile birlikte kullanılmayan yedek pinler açıklamalı 

olarak anlatılmaktadır. 

Çizelge 2.2 J9 pin bloğu [36] 

Pin Pin Adı Pin Tipi Açıklaması 

 
 

1 

 
 

VBAT_IN 

 
 

Güç Girişi 

Batarya gerilim giriş pini. MSP430 ana 
platformu için, VIO_HOST = VBAT_IN. 

Diğer platformlar için farklı gerilim 
seviyeleri mevcuttur. R14 direnci 

kaldırılabilir. 

2 VBAT_SW_EN Giriş Ana cihazdan sinyal geldiğinde aktif 
olarak “1” konumuna gelir. 

3 Rezerve – Rezerve 

4 Rezerve – Rezerve 

5 Rezerve – Rezerve 

6 Rezerve – Rezerve 

7 WL_SPI_CLK Giriş SPI clock girişi 

8 Rezerve – Rezerve 

9 Rezerve – Rezerve 

10 Rezerve – Rezerve 

 

Çizelge 2.3’te J10 pin grubunda yer alan Ground, SPI Kesme, SPI Veri Girişi, SPI Veri 

Çıkışı ve yedek olarak bırakılan rezerve pinler gösterilmiştir. 
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Çizelge 2.3 J10 pin bloğu [36] 

Pin Pin Adı Pin Tipi Açıklaması 

1 GND – Ground 

2 WL_SPI_IRQ Çıkış SPI kesme  

3 WL_SPI_CS Giriş SPI cip seçimi 

4 Rezerve – Rezerve 

5 Rezerve – Rezerve 

6 WL_SPI_DIN Giriş SPI veri girişi 

7 WL_SPI_DOUT Çıkış SPI veri çıkışı 

8 Rezerve – Rezerve 

9 Rezerve – Rezerve 

10 Rezerve – Rezerve 

2.3 Kablosuz Erişim ve Kontrol Kartı 

Klimayla kablosuz haberleşecek olan uzaktan erişim ve kontrol kartında MSP430F5529 

ve CC3000 geliştirme kartlarının yanı sıra elektronik olarak sahip olması gereken 

infrared alıcı, buzzer, bildirim ledleri ve butonlar kullanıldı. IR alıcı olarak TSOP4838SJ1 

[37] kullanıldı. 3 farklı bildirim ledi ve basıldığında “1” basılı olmadığında “0” işareti 

veren butonlar kullanıldı. 

Şekil 2.9’da yapılan kartın sahip olduğu teknik donanımlar gösterilmiştir. Şekil 2.10’da 

uzaktan erişim ve kontrol kartının dizgi düzeni gösterilmiştir. Şekil 2.11’de ise prototip 

kartın devre şeması verilmiştir. 
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Şekil 2.9 Uzaktan erişim ve kontrol kartının sahip olduğu donanım ve kompanentler 

 

Şekil 2.10 Uzaktan erişim ve kontrol kartının sahip olduğu donanım ve kompanent dizgi 
yerleşim planı 
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Şekil 2.11 Uzaktan erişim ve kontrol prototipinin Devre Şeması 

2.3.1 Uzaktan erişim ve kontrol prototip elektronik kartının blok diyagramları 

Yapılan prototip kart; bildirim, kontrol, haberleşme ve insan etkileşim arayüzünden 
oluşmaktadır. 

2.3.1.1 Bildirim arayüzü 

Prototip kartın bildirim arayüzünde 3 adet bildirim ledi bulunmaktadır. Ek olarak 3 adet 
buton grubu ve buzzer ses birimi bulunmaktadır. Bildirim ledleri; komut bilgisinin 
alındığını ve hangi modda çalıştığının kullanıcıya aktarılması için kullanılmıştır. Buton 
grubu ise manuel olarak sistemi yeniden başlatmak, klimayı açıp kapatmak ve klimanın 
çalışma modunu seçmek için kullanılmıştır. Ses birimi ise komut alındığının ya da 
herhangi bir arıza oluştuğunun kullanıcıya bildirilmesi için kullanılmıştır. 
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Şekil 2.12 Bildirim arayüzü 

Çizelge 2.4 Bildirim arayüzünün işlemci pin bağlantıları 

 

2.3.1.2 Kontrol birimi 

Kontrol arayüzü mikro kontrolör barındıran MSP430F5529 geliştirme kitidir. Bu 
geliştirme kitinin prototip kartta bulunan (CC3000 geliştirme kiti hariç) giriş çıkış 
birimlerini kontrol etmek için 21 – 40 numaralı pinler de dahil olmak üzere 20 adet giriş 
çıkış pininden yararlanılmıştır.   
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Şekil 2.13 Kontrol birimi 

2.3.1.3 Haberleşme birimi 

Haberleşme biriminde kontrol birimine direkt olarak monte edilen CC3000 geliştirme 
kartı (J1 ve J2 nolu pin gruplarına monte edilen), seri haberleşmeyi sağlayan Rx-Tx giriş 
çıkış birimi ve uzaktan kumanda fonksiyonlarını kullanabilmek için IR giriş pini 
bulunmaktadır. Şekil 2.14’te kablosuz haberleşme birimi ile mikro kontrolör birimin 
birleşimi gösterilmiştir. 

 

Şekil 2.14 Kablosuz haberleşme birimi – J1 ve J2 pin grubu 

Şekil 2.15’te haberleşme biriminin blok yapısı gösterilmektedir. Çizelge 2.5’te 
haberleşme birimi ve mikro kontrolör arasındaki pin bağlantı numaraları gösterilmiştir. 
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Şekil 2.15 Haberleşme birimi blok yapısı 

Çizelge 2.5 Haberleşme birimi pin numaraları 

 

2.3.1.4 İnsan etkileşim arayüzü 

İnsan etkileşim arayüzünde bir sıvı kristal ekran bulunmaktadır. Yapı Şekil 2.16’da 
gösterilmiştir. Sıvı kristal ekran 16 sütun ve 2 satırdan oluşmaktadır. Sıvı kristal ekranın 
pin bağlantısının nasıl yapıldığı Çizelge 2.6’da gösterilmektedir. 
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Şekil 2.16 İnsan klima etkileşim arayüzü blok yapısı 

Çizelge 2.6 Sıvı kristal ekran ve mikro kontrolör pin bağlantıları 

 

Şekil 2.17’de yapılan kartın baskı devre çiziminin 3 boyutlu görünümünün üst görünüşü 

verilmiştir. Şekil 2.18’de uzaktan erişim ve kontrol kartının baskı devresinin 

gerçeklenmiş halinin  üst görünüşü gösterilmiştir. Şekil 2.19’da ise yapılan prototip 

kartın baskı devre çiziminin 3 boyutlu görünümünün alt görünüşü verilmiştir. 
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Şekil 2.17 Uzaktan erişim ve kontrol prototipinin PCB çizimi üst görünüş 

 

Şekil 2.18 Uzaktan erişim ve kontrol prototip kartının PCB üst görünüşü 
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Şekil 2.19 Uzaktan erişim ve kontrol prototipinin PCB çizimi alt görünüş 

Şekil 2.20’de uzaktan erişim ve kontrol kartının baskı devresinin gerçeklenmiş halinin  

alt görünüşü gösterilmiştir. Şekil 2.21’de ise yapılan prototip kartın baskı devre 

kompanent dizgi ve montajının tamamlanmış halinin üst görünüşü verilmiştir. Şekil 

2.24’te ise yapılan prototip kartın baskı devre kompanent dizgi ve montajının 

tamamlanmış halinin alt görünüşü verilmiştir. 
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Şekil 2.20 Uzaktan erişim ve kontrol prototip kartının PCB üst görünüşü 

 

Şekil 2.21 Uzaktan erişim ve kontrol prototip kartının PCB alt görünüşü 
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Şekil 2.22 Uzaktan erişim ve kontrol prototipi baskı devre üst kat çıktısı 

 

Şekil 2.23 Uzaktan erişim ve kontrol prototipi baskı devre altt kat çıktısı 
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Şekil 2.24 Dizgi ve montajı yapılan prototip kartın alt görünüşü 

 

 

Şekil 2.25 Dizgi ve montajı yapılan prototip kartın alt görünüşü 



 

45 

 

BÖLÜM 3 

SİSTEM MİMARİSİ ve YAZILIM GELİŞTİRME ADIMLARI 

Bu bölümde tez çalışmasında yapılan çalışmalar sırasıyla, sistem mimarisi, gömülü 

yazılım adımları, mobil uygulama arayüzü, web tabanlı kontrol arayüzü ve çalışmalar 

sırasında yapılan bazı örnek uygulamaların anlatıldığı test bölümü yer almaktadır.  

3.1 Sistem Mimarisi 

Klimaya uzaktan erişim ve kontrol sistem mimarisinde iki seçenek belirlenmiştir. İlkinde 

klimanın kurulu olduğu ev, ofis ya da herhangi bir mekan içerisinde klimaya mobil cihaz 

ya da bilgisayar üzerinden erişim ve kontrolün sağlanması öngörülmüştür. Bu yapıda 

sürekli bir internet bağlantısına ihtiyaç duyulmamaktadır. Sadece kablosuz ağ mevcut 

olsa bile klimaya erişim ve kontrol sağlanabilmesi tercih edilmiştir. Ev/Ofis gibi 

mekanların içerisindeyken oluşan sistem mimarisi Şekil 3.1’de gösterilmiştir. 

 

Şekil 3.1  Klimaya ev/ofis içerisinde bulunan kablosuz yerel ağ üzerinden erişim 
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İkinci mimari seçenek ise klimanın kurulu olduğu ortam dışından internet ağı 

kullanılarak klimaya erişim ve kontrolün sağlanması hedeflenmiştir. Bu seçenekte 

sürekli bir internet ağ bağlantısı gerekmektedir. Klimaya bağlı olan kablosuz ağ 

modülünün ev/ofis içerisinde bulunan kablosuz internet şebekesine sürekli olarak bağlı 

olması gerekmektedir. Bağlantı kopmadığı sürece dünyanın heryerinden kullanıcı 

klimasına erişim ve kontrol sağlayabilmektedir.  Ev/Ofis gibi mekanların dışından yani 

herhangi bir yerden klimaya erişim ve kontrolü sağlayan sistem mimarisi Şekil 3.2’de 

gösterilmiştir. 

 

Şekil 3.2 Klimaya ev/ofis dışından interneti ağı üzerinden erişim ve kontrol 

3.2 Gömülü Yazılım Adımları 

Gömülü yazılım safhasında yazılım esnekliği, kütüphane seçenekleri, kullanım kolaylığı, 

ücretsiz lisans gibi kriterler göz önüne alınarak ücretsiz bir gömülü yazılım geliştirme 

ortamı olan Energia IDE seçilmiştir. Versiyon olarak 0101E0013 [38]  kullanılmıştır. 

3.2.1 Gömülü Yazılım Akış Şeması 

Şekil 3.3’te gömülü yazılımın akış şeması verilmiştir. Şemada görüleceği üzere, uzaktan 

erişim ve kontrol prototipi enerji verildiğinde öncelikle kablosuz alan adı ve şifresi ile 

kablosuz ağa erişim yapılır. Erişim sağlandığında sıvı kristal ekran üzerinde bağlantının 
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sağlandığını gösteren bir bildirim metni görülür. Bağlantı başarıyla yapıldıktan sonra 

sistem dinleme modunda beklemeye geçer. Herhangi bir kullanıcı uzaktan erişim ve 

kontrol prototopine bağlandığında sistem gelecek komutu beklemeye başlar. Herhangi 

bir kumanda kontrol fonksiyon komutu alındığında gelen komut analiz edilerek; 

klimanın çalıştırılması/kapatılması, çalışma modu, sıcaklık bilgisi, fan bilgisi, yatay ve 

dikey kanatların konumları gibi fonksiyonlar çözümlenir. Bu işlem başladığında buzzer 

ses birimi ile komutun alındığına dair bildirim yapılmaktadır. Ses birimiyle eş zamanlı 

olarak sıvı kristal ekran üzerinde analiz sonucunda çözülen ilgili komutun bilgileri 

(çalışma modu, set edilen sıcaklık değeri, fan seviyesi, yatay ve dikey kanat konumu 

gibi) verilir. Komut çözümlemesi yapıldıktan sonra ilgili komutun bilgisi seri haberleşme 

birimi üzerinden klima iç ünite kontrol kartına gönderilir ve klimanın ilgili komuta göre 

çalışması/durması sağlanır. Seri haberleşme sağlandıktan sonra yeni bir komut gelene 

kadar sistem beklemeye geçer. Döngü bu şekilde devam etmektedir. 



 

48 

 

 

Şekil 3.3 Gömülü yazılım akış şeması 

3.2.2 Kumanda İşaretlerinin Çıkarılması ve Gömülü Yazılıma Eklenmesi 

Geleneksel kumandanın göndermiş olduğu sinyaller IR alıcılar sayesinde alınır ve mikro 

işlemciye gönderilir. Gönderilen bu sinyali mikro işlemcinin tanıması gerekir. Gelen bu 

sinyaller bir şifreleme protokolüyle gelmektedir. Bu tez çalışmasında kullanılan 

geleneksel klima kumandası NEC protokolünü kullanmaktadır. Bu protokolde önce 12-
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13,5 ms lik frekansında başlangıç sinyali gönderilmektedir.  Daha sonra 8 bitlik cihaz 

kodu, 8 bitlik Data A ve Data B bitleri ile en son olarak 4 bitlik kontrol biti 

gönderilmektedir. NEC protokolü genellikle 32 bit olarak tasarlanmıştır.  Fakat bu tez 

çalışmasında kullanılan kumandanın protokolü 28 bit olduğu görüldü. Energia 

geliştirme kütüphanesinde 28 bit şifrelemeye göre kütüphane düzenlemesi yapıldı. 

Geliştirme ortamının 28 bit NEC protokolüne uyumunun testinden sonra geleneksel 

klima kumandasının yaptığı tüm işlemlerin artık kablosuz erişim arayüzleri üzerinden 

yapılabilmesi için bu fonksiyonların çözümlemesi yapıldı. Her bir tuşun taşıdığı sinyalin 

16 lık sistemde karşılığı bulundu. 

Bu tez çalışmasında testlerde kullanılan geleneksel klima kumandası Şekil 3.4’te 

gösterilmiştir. 

 

Şekil 3.4 Tez çalışmasında kullanılan klima kumandası [39] 

Bu tez çalışmasında kullanılan NEC protokolünün sinyal gösterimi Şekil 3.5’te 

gösterilmiştir. 
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NEC CODE

12-13.5 ms

1 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 1 1 0 1 0 0 0 1 1

88 0 0 3 4 7

1

1-1.2 ms

2-2.4 ms

Custom Code DataA DataB Check Sum

 

Şekil 3.5 NEC protokolü 

3.3 Mobil Uygulama Arayüzü 

Mobil uygulama platformu olarak Android işletim sistemi seçildi. İşletim sistemi 

versiyonu Android 4.0 ve üzeri olarak belirlendi. Mobil uygulama arayüzü olarak 

Massachusetts Institute of Technology’nin geliştirmiş olduğu web tabanlı MIT 

AppInverter2 [40]. AppInverter2 uygulaması fonksiyon blokları ve bazı script 

fonksiyonlar yazılarak oluşturulan kullanıcı dostu bir Android uygulama geliştirme 

arayüzüdür. Bu uygulama Yıldız Teknik Üniversitesi Elektronik ve Haberleşme 

Mühendisliği Lisans öğrencisi Hamraz Javaheri ile birlikte TÜBİTAK 2241-A Sanayi 

Odaklı Lisans Bitirme Tezi Destekleme Programı 2014/9 döneminde desteklenmiş olan 

projesi kapsamında geliştirilmiştir.  

Uygulamayı kullanmak için bir kullanıcı hesabı oluşturulmalıdır. Mobil uygulamada 

hesap oluşturmak için Facebook, Twitter gibi soysal platformlar kullanılmıştır. 

Böylelikle bu sosyal platformlar sayesinde onları kullanırken klimanızı izleyebilmeniz ve 

kontrol edebilmeniz amaçlanmıştır. Kullanıcı hesabı oluşturulduktan sonra giriş 

yapılmalıdır. Mobil uygulama giriş sayfası Şekil 3.6’da gösterilmiştir.  
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Şekil 3.6 Android mobil uygulama giriş sayfası 

Giriş aşaması başarıyla tamamlandıktan sonra kullanıcının sahip olduğu klima/ların 

listesinin olduğu “Benim Klimam” sayfasıyla karşılaşılacaktır. Benim Klimam sayfası 

Şekil 3.7’de gösterilmiştir. Kullanıcı ilk kez giriş yaptığında sahip olduğu klimayı 

uygulamaya tanıtmak için Şekil 3.7’de görülen  “Ekle” butonuna tıklayarak 

klimasının bilgilerini girip klima ekleme işlemini tamamlamalıdır. 

 

Şekil 3.7 Android mobil uygulama benim klimam sayfası 
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Klima ekleme işlemini tamamladıktan sonra ekranda eklenen klimanın belirtildiği bir 

düğme görülecektir. Bu düğmeye tıkladığınızda klimanın ana kontrolünün sağlandığı 

“Klima Kontrol Sayfası” görülecektir. Bu sayfa sayesinde klimanın çalışma modu, 

sıcaklık ayarı, fan hızı ayarı ile yatay ve dikey kanat modları tek tek ayarlanabilmektedir. 

Mobil uygulama cinsiyete bağlı olarak sayfaların renklendirilmesine olanak 

sağlanmaktadır. Şekil 3.8’de “Klima Kontrol” sayfasının kişiye özgü renklendirilmiş 

görselleri verilmiştir. 

 

Şekil 3.8 Android mobil uygulama klima kontrol sayfası 

 

Mobil uygulama kullanıcının klima kontrol seçeneklerini kaydetmesine olanak 

vermektedir. Android uygulamada kullanıcıların bu özelliği kullanabilmesi için 

“Favorilerim” sayfasını bulunmaktadır. Kullanıcı favori sayfasına girmek için  

“Favori” düğmesine tıklaması gerekmektedir. Herhangi bir favori olmadığı takdirde 

Şekil 3.9’da gösterilen sayfa görülecektir.  
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Şekil 3.9 Android mobil uygulama favorilerim sayfası 

Favori eklemek için  “Ekle” düğmesine tıklanmalıdır. Şekil 3.10’da gösterilen 

“Favori Ekleme” sayfasında gerekli alanların doldurulup kaydedilmesi gerekmektedir.  

 

Şekil 3.10 Android mobil uygulama favori ekleme sayfası 

Şekil 3.11’de gösterilen sayfada kayıtlı olan favori çalışma modları görülmektedir. 

Kullanıcı bu modlardan herhangi birine tıkladığında klima seçili favori modun kapsadığı 

tüm ayarlara göre çalışacaktır. 



 

54 

 

 

Şekil 3.11 Kayıtlı favoriler 

Mobil uygulamaların genelinde yer alan “Ayarlar” sayfası şekil 3.12’de gösterilmiştir. Bu 

sayfada Klima Kaydı, Sıcaklık Göstergesi, Kullanıcı Hesap Girişi, Kullanıcı Listesi, Hesap 

Silme, Kullanım Kılavuzu gibi araçlara bu sayfa üzerinden erişilmektedir.  

 

Şekil 3.12 Android mobil uygulama ayarlar sayfası 

Mobil uygulama çalıştırıldığında mekanda var olan kablosuz ağ üzerinden mobil cihaz 

klimaları aramaya başlamaktadır. Uyumlu kimlik yapısına sahip klimayı otomatik olarak 

bulmaktadır. Klimaya erişim sağlandıktan sonra, “Klima Ekleme“ sayfasından klimanın 

uygulamaya tanıtılması gerekmektedir. Bir defa eşleştirilen klimaya mekan içerisinden 



 

55 

 

ya da mekan dışından erişim sağlanabilmektedir. Her yeni klima için bu adımların 

tekrarlanması gerekmektedir. 

3.3.1 Mobil Uygulama Akış Şeması 

Yapılan mobil uygulamanın akış şeması sırasıyla aşağıda verilmiştir. 

1.Giriş adımı: Uygulama açıldığında kullanıcının bir güvenlik adımı üzerinden giriş 

yapması gerekmektedir. Bu güvenlik kontrolü için kullanıcının bazı bilgilerini girerek 

sisteme kayıt olması gerekmektedir. Kullanıcı kayıt işlemini yapmak için 2. adımda 

anlatılan kayıt sayfasına giderek bilgilerini doldurup kayıt işlemini tamamlamalıdır. 

Kayıtlı kullanıcı ise giriş işlemini yaptıktan sonra 3. adıma geçişi sağlanmaktadır. Giriş 

adımı yazılım akış şeması Şekil 3.13’te gösterilmiştir. 

 

Şekil 3.13 Giriş sayfası akış şeması 
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Kullanıcı giriş işlemini yaparken şifresini hatırlamıyorsa Şifremi Unuttum düğmesine 

tıklayarak yeni şifresini alabilmektedir. Şifre yenileme akış diyagramı Şekil 3.14’te 

gösterilmiştir. 

 

Şekil 3.14 Şifre yenileme yazılımı akış diyagramı 
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2.Kayıt adımı: Kullanıcı ilk defa uygulamayı kullandığında sisteme kaydolmak 

zorundadır. Giriş sayfasından kayıt bağlantısını kullanarak açılan sayfada gerekli 

bilgilerini doldurduktan sonra kayıt işleminin başarıyla tamamlandığı bilgisini alacaktır. 

Bu bilgiyi almıyorsa eksik bilgilerini tamamlamalıdır. Kayıt başarılı ise kullanıcı sisteme 

giriş yapması için tekrar 1. adıma yönlendirilmektedir. Kayıt adımının yazılım akış 

şeması Şekil 3.15’te gösterilmektedir. 

 

Şekil 3.15 Kayıt adımı yazılım akış şeması 
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3. Klimalarım ve klima ekleme adımı: Giriş işlemini yaptıktan sonra kullanıcıyı 

klimalarım ve klima ekleme sayfası karşılamaktadır. Bu sayfada herhangi bir klima kaydı 

yoksa sadece “EKLE” düğmesi ile karşılaşılacaktır. Bu düğmeye tıklayarak kullanıcının 

sahip olduğu klimanın çeşitli bilgileri (satın alma tarihi, klimanın tipi, klimanın seri 

numarası, klimaya verilen takma ad gibi) girerek sisteme kaydı yapılmaktadır. Kaydı 

tamamlanan/mevcut olan klimanın adının görüldüğü bir düğme sayfada belirecektir. 

Bu düğmeye/düğmelere tıklayarak klimanın kontrolünün sağlandığı 4. adımda anlatılan 

kontrol sayfasına geçilmektedir. Klimalarım ve klima ekleme adımı akış şeması Şekil 

3.16’da gösterilmektedir. 

 

Şekil 3.16 Klimalarım ve klima ekleme yazılımı akış şeması 
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4. Kontrol adımı: Bu adımda kayıtlı ve bir önceki adımda seçilmiş olan klimanın kontrolü 

sağlanmaktadır. Geleneksel klima kumandası üzerinde var olan fonksiyonların 

görüleceği bu ekranda kullanıcı istediği fonksiyonu kullanarak klimasını kontrol 

edebilmektedir. Ayrıca kullanıcı sayfanın alt kısmında bulunan favori düğmesini 

kullanarak 5. adımda anlatılan favori seçme ve kaydetme işlemini yapabilmektedir. 

Klima kontrolünün sağlayan fonksiyonların kullanıldığı klima kontrol yazılımı akış 

şeması Şekil3.17’de gösterilmektedir. 

 

Şekil 3.17 Klima kontrol yazılımı akış şeması 
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5.Favori seçme ve kayıt adımı: Bu adımda kullanıcı sürekli kullanmayı tercih ettiği 

çalışma modunu, sıcaklık seviyesini ve fan hızını seçerek bunlara bir de isim vererek 

favori çalışma modunu belirleyebilir. İstenildiği kadar favori mod kaydı yapılabilir. 

Klimanın kontrolü için kullanıcının favorilerim düğmesine tıklayıp karşısına çıkacak olan 

favori/favoriler arasından istediği modu seçtiğinde klima bu moda göre otomatik olarak 

çalışmaya başlayacaktır. Favori mod oluşturma ve favori çalışma seçeneğinin seçildiği 

yazılımın akış şeması Şekil 3.18’de gösterilmiştir. 

 

Şekil 3.18 Favorilerim ve favori ekleme adımı yazılım akıl diyagramı 
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6. Genel ayarlar adımı: Bu adımda kullanıcı kayıtlı klimalarının bilgilerini, tercih ettiği 

sıcaklık birimini, kullanıcı hesabının dondurulması ya da silinmesi, kullanım kılavuzu gibi 

bilgi ve fonksiyonlara erişip istediği değişiklikleri yapmaktadır. 

3.4 Web Tabanlı Kontrol Arayüzü 

Web tabanlı kontrol arayüzünün tasarlanmasından önce bir Java tabanlı masaüstü 

uygulama geliştirildi. Bu uygulama da mobil uygulama gibi kontrol özelliklerine sahip 

olarak tasarlandı. Test aşamalarında Java uygulamasının bazı dezavantajlarının olduğu 

görüldü. Başlıca handikabı bir “exe” uzantılı uygulama olduğundan her bilgisayara 

kurulum yapılması gerekli olması ve güncelleme yapılmak istenmesi durumunda 

karşılaşacak çeşitli zorlukları barındırmasıydı. Bu nedenle Java tabanlı uygulama yerine 

PHP tabanlı bir WEB arayüzü geliştirildi. Bu uygulamanın en önemli avantajı internet 

tarayıcı olan her cihazda çalışabilir olmasıdır. Bu sayede mobil uygulamayı kullanmak 

istemeyen kullanıcılar için de uygun olduğu görüldü. Mobil uygulamaya paralel olarak 

işletim sisteminden bağımsız olarak tüm bilgisayarlarda kullanılabilecek bir PHP tabanlı 

WEB uygulaması geliştirildi. Bu arayüz Adobe Dreamviewer CS6 [41] geliştirme aracıyla 

tasarlanıp geliştirildi. Dreamviewer ücretli bir web arayüz geliştirme aracıdır.  

Bu uygulamada mobil uygulamada olduğu gibi “Giriş Sayfası”, “Kayıt Sayfası”, “Ana 

Kontrol Sayfası”, “Benim Klimam Sayfası”, “Klima Ekleme Sayfası”, “Akıllı Klima 

Kumandası Sayfası” bulunmaktadır. Şekil 3.19’te tasarlanan sayfalardan “Giriş Sayfası” 

Dreamviewer CS6 üzerinde simülasyonu gösterilmiştir. Geliştirilen bu arayüzde 

kullanıcı bilgileri ve klima bilgilerinin depolandığı bir veri tabanı bulunmaktadır. Veri 

tabanı oluşturulurken SQL programlama dili ve PHPMyAdmin web tabanlı bir arayüz 

kullanılmıştır. Veri tabanı sunucu olarak ApacheFriends oluşumunun geliştirdiği 

XAMMP [41] sunucu programı kullanılmıştır. Kullanılan sunucu versiyonu 

ApacheFriends XAMPP Version 5.5.19’dir.  
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Şekil 3.19 Dreamviewer CS6’da tasarlanan Giriş sayfası simülasyonu  

3.4.1 Web Tabalı Arayüz Yazılımının Akış Şeması 

Yapılan web tabanlı php arayüzün yazılımının akış şemaları Şekil 3.20, Şekil 3.21, Şekil 

3.22, Şekil 3.23 ve Şekil 3.24’te gösterilmiştir. Şemalarda görüleceği üzere yazılım şu 

şekilde çalışmaktadır. 

1.Giriş adımı: Kullanıcı internet adresini tarayıcısına yazıp girdiğinde arayüzün giriş 

sayfasına erişilmektedir. Bu sayfada sisteme giriş yapabilmek için kullanıcı adı, mail 

adresi ve şifrenin girileceği alanlar ile bir diğer giriş seçeneği olan Facebook ile giriş 

opsiyonu kullanılarak sisteme giriş yapılması gerekmektedir. Kullanıcı sisteme kayıtlı 

değil ise 2. adımda anlatılan kayıt işlemlerini yapmalıdır.  Kayıtlı kullanıcı ise giriş 

işlemini yaptıktan sonra 3. adıma geçişi sağlanmaktadır. 
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Şekil 3.20 Giriş sayfası yazılım akış şeması 
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Şekil 3.21 Şifremi unuttum – şifremi hatırlat yazılım akış şeması 

2.Kayıt adımı: Kullanıcı ilk defa uygulamayı kullandığında sisteme kaydolmak 

zorundadır. Giriş sayfasından kayıt bağlantısını kullanarak açılan sayfada gerekli 

bilgilerini doldurduktan sonra kayıt işleminin başarıyla tamamlandığı bilgisini alacaktır. 

Aynı şekilde Facebook ile Kaydol düğmesine tıklanırsa kullanıcı Facebook aracılığıyla 

ilgili izinleri vererek sisteme kaydolabilmektedir. Bu seçenekte de kaydın başarılı 

olduğu bilgisi ile kullanıcı bilgilendirilecektir. Bu bilgiyi almıyorsa eksik bilgilerini 

tamamlamalıdır. Kayıt başarılı ise kullanıcı sisteme giriş yapması için tekrar 1. adıma 

yönlendirilmektedir. 
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Şekil 3.22 Kayıt sayfası yazılım akış şeması 
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3. Kontrol adımı: Giriş işlemi doğru bir şekilde tamamlandığı takdirde web arayüzün 

klimayı kontrol edebileceğimiz Ana Kontrol Sayfası ile karşılaşılmaktadır. Bu sayfada 

kullanıcı klima ekleme, kayıtlı klimalarını görme, akıllı klima kumandasına erişme, klima 

hakkında çeşitli bilgilerin gösterildiği bir grafik ve klimanın çalışmasıyla ilgili bilgilerin 

tutulduğu kayıt tablosuyla karşılaşmaktadır. Kullanıcı kayıtlı bir kliması yoksa klima ekle 

düğmesine tıklayarak 4. adımda anlatılan klima ekleme sayfasına yönlendirilecektir. 

Kullanıcı kayıtlı klimalarını görmek istediği takdirde Klimalarım düğmesine tıklayarak 5. 

adımda anlatılan Klimalarım sayfasına yönlendirilecektir. Kullanıcı klimasını kontrol 

etmek için Akıllı Klima Kumandası düğmesine tıklayarak 6. adımda anlatılan klima 

kumandası sayfasına yönlendirilecektir. 

 

Şekil 3.23 Klima kontrol sayfası yazılım akış şeması 
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4.Klima ekleme adımı: Bu adımda mobil uygulamada olduğu gibi kullanıcıdan kliması 

hakkında seri numarası, klima tipi, klima serisi, satın alma tarihi, IP adresi ile birlikte 

klimaya bir ad vermesi istenmektedir. Tüm bilgileri eksiksiz girip “Ekle” düğmesine 

basıldığında kayıt işlemi tamamlanır ve 3. adıma geri dönülür. 

5.Klimalarım adımı: Kullanıcı tarafından sisteme kaydedilmiş tüm klimaların bilgileri bu 

sayfada gösterilmektedir. Kullanıcı hangi klimasının çalışıp çalışmadığını ya da hangi 

moda çalıştığını bu sayfa üzerinden görebilmektedir. Kullanıcı istediği bilgileri 

gördükten sonra sayfayı kapatabilmekte ve 3. adıma dönebilmektedir. 

6.Akıllı Klima Kumandası adımı: Bu adımda kullanıcının seçmiş olduğu klimasını 

uzaktan kontrol edebileceği akıllı kumanda yer almaktadır. Akıllı kumanda üzerinde 

mevcut geleneksel klima kumandası üzerinden yer alan tüm kontrol ve bilgi 

fonksiyonları yer almaktadır. Kullanıcı istediği fonksiyonları kullanarak klimasının 

çalışmasını ya da kapanması sağlayabilmektedir. 

 

Şekil 3.24 Ana kontrol sayfası blok yapısı 

Şekil 3.25’te geliştirilen php tabanlı web arayüzün “Giriş” sayfası gösterilmektedir. 
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Şekil 3.25 PHP uygulama giriş sayfası 

Uygulamaya ilk defa giriş yapılması durumunda sisteme kayıt yapılması gerekmektedir. 

Kayıt için de aynı giriş opsiyonunda olduğu gibi Facebook ile kaydolma olanağı 

bulunmaktadır. Şekil 3.26’da Kayıt sayfası gösterilmiştir. Gerekli alanların 

doldurulmasından sonra “Kaydet” düğmesine tıklanarak kayıt işlemi tamamlanır ve 

uygulama kullanıcıyı Giriş Sayfası’na yönlendirmektedir.  
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Şekil 3.26 Kayıt sayfası 

Giriş Sayfasında gerekli bilgileri doldurduktan sonra PHP uygulama kullanıcıyı Şekil 

3.27’de gösterilen Ana Kontrol Sayfası’na yönlendirecektir. Ana Kontrol Sayfası’nda  

“Klima Ekleme”, “Benim Klimam”, “Akıllı Klima Kumandası” ve klima hakkında çeşitli 

bilgilerin olduğu alanlar bulunmaktadır.  
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Şekil 3.27 Ana kontrol sayfası 

Şekil 3.28’de gösterilen Klima Ekleme ve Şekil 3.329’da gösterilen Benim Klimam 

sayfalarının çalışma şekli Android uygulamayla aynı şekildedir. Şekil 3.30’da Akıllı Klima 

Kumandası geleneksel klima kumandasında var olan kontrol fonksiyonlarına sahiptir.  
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Şekil 3.28 Klima Ekleme Sayfası 

 

Şekil 3.29 Benim Klimam Sayfası 
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Şekil 3.30 Akılı klima kumandası 

Ana kontrol Sayfası’nda kullanıcının seçmiş olduğu klima hakkında çalışma durumu, 

çalışma modu, güç tüketimi gibi bazı genel bilgiler de gösterilmektedir.  

PHP uygulama mobil uygulamada olduğu gibi aynı anda sadece bir kullanıcı giriş 

yapabilmektedir. Bunun nedeni ise haberleşme altyapısının ve uygulamaların geliştirme 

aşamasında klimanın güvenli kontrolünün amaçlanmasıdır. 

3.5 Testler 

Bu tez çalışmasının donanım uygulaması aşamasında çeşitli testler yapıldı. 

Bunların başında; 

Analog veri okuma ve yazma 

Dijital veri okuma ve yazma 

16x2 Karakter Sıvı kristal ekran sürme 

UART seri haberleşme 
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Kablosuz ağ haberleşme 

Mail gönderme 

Hava durumu bilgileri sorgulama 

gibi testler gelmektedir. 

Texas Instruments firmasının MSP430F5529 geliştirme kartıyla yukarıda bahsedilen 

testler sırasıyla yapılmıştır. 

Şekil 3.31’de iki adet MSP430F5529 geliştirme kitinin seri haberleşmesinin Serial 

Monitor üzerinden izlenmesi gösterilmiştir. Haberleşme hızı 9600 bps’dir. 

 

Şekil 3.31 Seri Haberleşme Test Çıktısı 

Şekil 3.32 ve Şekil 3.33’te kablosuz ağ haberleşme yapan MSP430F5529 geliştirme kiti 

ve CC3000 kablosuz ağ geliştirme kitinin olduğu donanım kullanılarak istenilen mail 

adresine mesaj atıldığının bilgisi gösterilmiştir. 
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Şekil 3.32 Mail gönderim uygulaması serial monitor çıktısı 

 

Şekil 3.33 Mail gönderim -  alınan mail çıktısı 

MSP430F5529 geliştirme kitinin üzerinde kullanılabilecek dijital ve analog giriş – çıkış 

birimleri yer almaktadır. Şekil 3.34’te geliştirme kitinin üzerinde yer alan kırmızı 

bildirim ledinin ve Şekil 3.35’de yeşil bildirim led arayüzlerinin dijital olarak 

kontrolünün çıktıları gösterilmiştir. 

 

Şekil 3.34 Dijital çıkış birimi kontrolü – kırmızı led 
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Şekil 3.35 Dijital çıkış birimi kontrolü – yeşil led 

CC3000 kullanılarak yapılan kablosuz haberleşmenin seri haberleşme kullanılarak Serial 

Monitor üzerinde elde edilen çıktısı Şekil 3.36’da verilmiştir. Bu test uygulamasında 

sistem SSID – kablosuz ağ alan adı ve güvenlik şifresi bilinen belirli bir kablosuz ağa 

başarıyla bağlanmıştır. 

 

Şekil 3.36 SSID ve şifresi bilinen kablosuz ağa erişimin serial monitor çıktısı 
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Şekil 3.37, Şekil 3.38, Şekil 3.39 ve Şekil 3.40’da klima iç ünitesiyle haberleşen uzaktan 

erişim ve kontrol kartının görüntüleri verilmiştir. Kart ve bilgisayar arasında kullanılan 

seri haberleşme hızı 19200 bps, klima iç ünitesi ile uzaktan erişim ve kontrol kartı 

arasında yapılan seri haberleşmenin hızı ise 9600 bps olarak belirlenmiştir. Gömülü 

yazılıma dahil edilen Wi-Fi SSID ve Password bilgileri sayesinde klima iç ünite kontrol 

kartının geliştirilen uzaktan erişim ve kontrol kartı üzerinden internet ağına bağlanması 

sağlandı. Aktif bağlantı sayesinde klimanın genel kullanımdan var olan kumanda 

fonksiyonları android tabanlı mobil uygulama ve web tabanlı PHP uygulama üzerinden 

kullanılabilir duruma getirildi. Klima kablosuz ağa bağlandığında, geliştirilen uzaktan 

erişim ve kontrol prototipinde yer alan 16x2 karakter sıvı kristal ekran üzerinde klima 

hakkında çeşitli bilgiler görülmektedir.   

 

Şekil 3.37 Prototip kart wi-fi bağlantısı var ve klima çalışmıyor 

 

 

Şekil 3.38 Prototip kart wi-fi bağlantısı var ve klima çalışıyor 
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Şekil 3.39 Klima Soğutma Modunda Çalışıyor 

 

Şekil 3.40 Klima ısıtma modunda çalışıyor 
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BÖLÜM 4 

SONUÇ VE ÖNERİLER 

Bu tez çalışmasında yapılan kablosuz elektronik erişim ve kontrol kartı sayesinde 

klimaya erişim ve kontrol sağlandı. Erişim ve kontrol için Android ve PHP tabanlı 

uygulamalardan yararlanıldı. Yerli üretimde ısıtma ve soğutma ürünlerinde eksik olan 

uzaktan erişim ve kontrol özelliği eksikliğinin giderilmesi için tam donanımlı uygulama 

gerçekleştirildi. Yapılan prototip elektronik kart seri üretime uygun hale getirildiğinde 

akıllı ev teknolojisine uygun klimaların ülkemizde yaygınlaşacağı öngörülmektedir. 

Yapılan uzaktan erişim ve kontrol prototipi tam çalışma anında 136mA akım 

çekmektedir(LCD-92,5mA, buzzer-40mA, ledler-90mA hariç). MSP430F5529 LP ve 

CC3000 Boosterpack tam çalışma anında maks. 450 mW enerji harcamaktadır. Prototip 

kart tüm donanımların maksimum çalışması durumunda 1,3 W güç tüketmektedir. Bu 

değerler uzaktan erişim ve kontrol teknolojinin eklenmesiyle klima üzerinde oluşacak 

olan güç tüketiminin minimum düzeylerde olduğunu göstermektedir. Yarı iletken 

teknolojisinin hızlı gelişimi sayesinde daha özellikli mikro işlemci ve kablosuz ağ çipleri 

çok daha uygun fiyatlara temin edilmektedir. Bu nedenle akıllı teknolojilerin ürünlere 

entegrasyonunda maliyet kriterinden kaynaklanan yerli ürünlerdeki fiyat dezavantajı 

giderek azalacağı öngörülmektedir. Bu tez çalışmasına ek olarak mobil uygulama NFC 

(Near Field Communication) teknolojisi kullanılarak klimanın kimlik bilgisi, IP adresi, 

teknik özelliklerinin mobil uygulamaya direkt olarak aktarılması sağlanabilir. Bu sayede 

kullanıcının mobil uygulamayı kullanım konforu arttırılabilir. 
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EK-A  

TSOP4838SJ1 

 

Şekil A. 1 TSOP4838SJ1 kullanım klavuzu 
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EK-B 

MSP430F5529 GELİŞTİRME KARTI 

 

Şekil B. 1 MSP430F5529 Geliştirme Kiti Kullanım Kılavuzu 
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Şekil B. 2 MSP430F5529 Geliştirme Kiti Kullanım Kılavuzu 
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EK-C 

CC3000 WI-FI KABLOSUZ HABERLEŞME GELİŞTİRME KARTI 

 

Şekil C. 1 CC3000 Wi-Fi Kablosuz Haberleşme Geliştirme Kiti Kullanım Kılavuzu 
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EK-D 

ENERGIA IDE 

Energia açık kaynak kodlu bir gömülü yazılım geliştirme aracıdır. Yazılım 

www.energia.nu/download/ adresinden en güncel verisyonları indirilmektedir. 

İndirilen dosya direk olarak çalışıtılmaktadır. Ekstra bir kurulum gerektirmez. Kullanılan 

geliştirme kartlarının USB sürücülerinin yüklenmesi gerekmektedir. Geliştirme ortamını 

ilk açtığımızda karşımıza Şekil D. 1’deki ekran gelmektedir. 

 

Şekil D. 1    Energia ide görsel arayüz 

Geliştirme ortamı Şekil D. 1’deki ekranla gelerek hemen yazılım geliştirmemize olanak 

sağlamaktadır.  

Yeni bir proje oluşturmak için; 

File → New ya da Ctrl+N tuşlarını kullanılmalıdır. Bu işlem Şekil D. 2’de gösterilmiştir. 

 

http://www.energia.nu/download/
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Şekil D. 2    Energia yeni proje açılması 

Mevcut bir projeyi açmak için; 

File → Open → projeAdi.ino ya da Ctrl+O → projeAdi.ino tuşlarını kullanılmalıdır.  Bu 

işlem Şekil D. 3’te gösterilmiştir. 

 

 

Şekil D. 3    Mevcut bir projeyi klasöründen açmak 

Mevcut bir projeyi geliştirme ortamı kütüphanesinden direkt açma için ise;  

File → Sketchbook → ProjeAdı kombinasyonu kullanılmalıdır. Bu işlem Şekil D. 4’te 

gösterilmiştir. 
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Şekil D. 4    Var olan bir projeyi kütüphane klasöründen açma 

Geliştirme ortamının kendi kütüphanesinde var olan örnek bir projeyi açmak için; 

File → Examples → ProjeAdı kombinasyonu kullanılmalıdır. Bu işlem Şekil D. 5’te 

gösterilmiştir. 

 

Şekil D. 5     Örnek bir projenin açılması 

Proje açıldıktan sonra yazılımın yükleneceği geliştirme kartı seçimi yapılır. Seçim 
yapılırken; 

Tools → Board → Elinizdeki_Geliştirme_Kartı (bu tez çalışması için MSP430F5529) 

kombinasyonu kullanılmalıdır. Bu işlem Şekil D. 6’da gösterilmiştir. 
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Şekil D. 6    Kullanılan Geliştirme Kartının Seçilmesi 

Geliştirme kartının seçiminden sonra yazılımın karta yükleneceği USB portunun 

seçilmesi gereklidir. Port seçimi için Windows 7 işletim sisteminde Aygıt Yöneticine 

gidilmelidir. Şekil D. 7’de görülen Ports (COM & LPT) sekmesinde kullanmış olduğunuz 

geliştirme kartının uygulama portu not edilmelidir. 

 

Şekil D. 7    Aygıt yöneticisinde geliştirme kartının kullanmış olduğu portun bulunması 

Aygıt Yöneticisi’nden ilgili port görüldükten sonra Energia geliştirme ortamında bu 

portun seçilmesi gereklidir. Port seçimi için; 
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Tools → Serial Port → COM(Aygıt Yöneticisinde Görülen COM numarası) kombinasyonu 

kullanılmalıdır. Bu işlem Şekil D. 8’de gösterilmiştir. 

 

Şekil D. 8    Seri portun seçilmesi 

 

Yazılımın tamamlanmasının ardından kaydetme işlemi mutlaka yapılmalıdır. Projeyi 

dosya adını değiştirilecek ise yeni adıyla kaydedilmelidir. Kayıt işleminden sonra yazılan 

kodda bir hata olup olmadığını anlamak için Şekil D. 9’da gösterildiği gibi Doğrula 

(Verify) düğmesine basılır ve hata bulma işleminin tamamlanması beklenir. Geliştirme 

ortamının siyah zeminli bilgi arayüzünde bir hata mesajı alınmadıysa kodda hata 

bulunmamıştır. 
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Şekil D. 9    Yazılımdaki hata doğrulama işlemi 

Geliştirme kartı seçimi, seri port seçimi ve doğrulama işleminin tamamlanmasının 

ardında yazılımın geliştirme kartına yüklenmesi için; 

File → Upload, Ctrl+U ya da Upload düğmesi kombinasyonlarından biri seçilmelidir. Bu 

işlem Şekil D. 10’da gösterilmiştir. 

 

Şekil D. 10    Yükleme düğmesi kullanılarak yazılımın geliştirme kartına yüklenmesi 

Bazı uygulamalarda seri haberleşme üzerinden bilgi alış verişi yapılmaktadır. Bu ve 

benzeri bilgi akışını gözlemlemek için Serial Monitor açılmalıdır. Serial Monitor USB 
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bağlantısı kullanılarak geliştirme kartıyla yapılan seri haberleşmenin izlenmesi sağlayan 

bir penceredir. Serial Monitor’u açmak için; 

File → Serial Monitor ya da Serial Monitor düğmesi kombinasyonu kullanılmalıdır.  Bu 

işlem Şekil D. 11’de gösterilmiştir. 

 

Şekil D. 11    Serial Monitor’un açılması 
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EK-E 

KUMANDA FONKSİYONLARININ HEX KARŞILIKLARI 

Çizelge E. 1’de 28 bit şifreli kumanda sinyalinin 16 lık sistemdeki karışıklıklarının 

bulunduğu değerler verilmiştir. Değerler Energia IDE geliştirme ortamında “IRremote” 

kütüphanesi kullanılarak bulunmuştur. 

Çizelge E. 1 Geleneksel klima kumandası sinyal çözümlemesi 

 Fonksiyon HEX formatı  Fonksiyon HEX formatı 

Soğutma 
modu 

 

18 °C 880830B 

Otomatik 
mod 

  

18 °C 880B342 

19 °C 880840C 19 °C 880B443 

20 °C 880850D 20 °C 880B544 

21 °C 880860E 21 °C 880B645 

22 °C 880870F 22 °C 880B746 

23 °C 8808800 23 °C 880B847 

24 °C 8808901 24 °C 880B948 

25 °C 8808A02 25 °C 880BA49 

26 °C 8808B03 26 °C 880BB4A 

27 °C 8808C04 27 °C 880BC4B 

28 °C 8808D05 28 °C 880BD4C 

29 °C 8808E06 29 °C 880BE4D 

30 °C 8808F07 30 °C 880BF4E 
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 Fonksiyon HEX formatı  Fonksiyon HEX formatı 

Isıtma 
modu 

 

16 °C 880C141 

Hava 
dolaşım 
modu 

 

KADEME1 880A30D 

17 °C 880C242 KADEME2 880A396 

18 °C 880C343 KADEME3 880A32F 

19 °C 880C444 KADEME4 880A3A7 

20 °C 880C545 KADEME5 880A341 

21 °C 880C646 OTOMATİK 880A352 

22 °C 880C747 

Dikey 
kanat 

 

1. ADIM 8813048 

23 °C 880C848 2. ADIM 8813059 

24 °C 880C949 3. ADIM 881306A 

25 °C 880CA4A 4. ADIM 881307B 

26 °C 880CB4B 5. ADIM 881308C 

27 °C 880CC4C 6. ADIM 881309D 

28 °C 880CD4D TAM 8813149 

29 °C 880CE4E KAPALI 881315A 

30 °C 880CF4F 

Yatay 
kanat 

 

1. ADIM 88130BF 

Nem alma 

 

KADEME1 8809902 2. ADIM 88130C0 

KADEME2 880999B 3. ADIM 88130D1 

KADEME3 8809924 4. ADIM 88130E2 

KADEME4 88099AC 5. ADIM 88130F3 

KADEME5 8809946 
3LÜ 

1.ADIM 
8813105 

OTOMATİK 8809957 
3LÜ 

2.ADIM 
8813116 

PLASMA 

 

ON 88C000C TAM 881316B 

OFF 88C0084 KAPALI 881317C 
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 Fonksiyon HEX formatı  Fonksiyon HEX formatı 

A/CLEAN 
ON 88C00B7 

POWER 
ON 8802305 

OFF 88C00C8 OFF 88C0051 
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EK-F 

DREAMVIEWER CS6 

 

Şekil F. 1    Adobe Dreamviewer CS6 ilk açılış ekranı 

Adobe firmasının bir ürünü olan Dreamviewer CS6 gelişmiş bir web tabanlı uygulama 
geliştirme ara yüzüdür. Program ücretlidir. Bu tez çalışmasında PHP tabanlı web ara yüz 
oluşturulurken Dreamviewer CS6 kullanılmıştır. Bu ara yüz birçok kolaylığı sunmaktadır. 
Veritabanı ve sunucu ayarlarını bu ara yüz üzerinden kolayca yapılabilmektedir. 
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EK-G 

PHPMYADMIN VERI TABANI TASARIM ARAYÜZÜ 

 

Şekil G. 1    phpMyAdmin veri tabanı tasarım arayüzü 
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